
Page 1 

CP322895 

AutoCAD Tips and Tricks to Improve Efficiency 
Josh Watson 
Mesa Associates Inc. 
 
Matt DeBord, P.E. 
Mesa Associates Inc. 

 

Description 

Do you find yourself behind on design projects? Do you want to familiarize yourself with AutoCAD 
better to become more efficient? In this class we will discuss how to manipulate settings/options 
to improve speed. We will also discuss how to set up drawings using x-refs and to utilize paper 
space and model space. We will also look at how layer commands and object display settings 
can reduce clutter in your drawings to make it easier to manipulate components in your drawing. 
This class will be a great class to help you become more familiar with some of the options in 
AutoCAD and make you take that next step in your career using the many tools AutoCAD has to 
offer.  
 

Speaker(s) 

Josh Watson is a Senior Structural Designer for Mesa Associates, Inc., a multi-discipline 
engineering firm with 16 offices and over 800 employees throughout the United States. Josh 
works in the Knoxville, TN office, which has about 325 employees. He has been at Mesa 
Associates, Inc. for over 11 years. Josh has more than 15 years’ experience working with 
Autodesk products and has experience working with Autodesk AutoCAD, AutoCAD Architecture, 
Civil 3D, Revit, ReCap, Plant 3D, Navisworks, and Vault. He is the lead technician at Mesa 
Associates, Inc. in their scanning to point cloud production. He has produced laser scanning 
training classes that have been incorporated into the corporate training database. In his free time, 
he enjoys spending time with his beautiful wife and four children.  
 
Matt DeBord is a Mechanical Engineer for Mesa Associates, Inc., a multi-discipline engineering 
firm with 16 offices and over 800 employees throughout the United States. Matt works in the 
Knoxville, TN office, which has about 325 employees. He has been at Mesa Associates, Inc. for 
over 11 years, where he works in the Power Generation business unit. Matt has a background in 
design and engineering of various piping systems, high energy piping stress analysis, finite 
element analysis, and hydraulics. He has experience working with Autodesk AutoCAD, Plant 3D, 
ReCap, Navisworks, Vault, and various other Autodesk Software's. He also has experience 
utilizing 3D laser scanning technology within design projects.

Learning Objectives 

• Manipulate settings in the options menu and keyboard shortcuts 

• Modify dimension style settings 

• Utilize various layering commands to display objects differently  

• Organize drawings using x-refs and model space / paper space 



Page 2 

Options Menu  

The options menu is accommodating in customizing the display and setting various settings. The 
options menu can be accessed in several different ways. You can click the red A in the upper left-
hand corner of AutoCAD, then click the “Options” button at the bottom. 
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You can also access the options menu by clicking Tools, then selecting Options at the bottom. 

 
 
You can also simply type in “Options” or “OP” in the command line. 
 
There are a couple of features worth pointing out that can save you some time while working with 
Autodesk products. The options menu will allow you to customize the way AutoCAD is displayed 
and hopefully make it easier for you to navigate.  
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Files Tab 

The files tab on the options menu is where you can find helpful information about where 
supporting files are saved on your machine. One function worth pointing out is the 
“Automatic Save File Location”. By clicking the + sign, you will be able to see where your 
autosave files are being stored. This can be a lifesaver when you get the dreaded “Fatal 
Error”. 

 
 

Display Tab 

The Display tab allows you to customize how AutoCAD appears. Under the “Layout 
Elements” section, there is a toggle button for “Display Layout and Model Tabs”. If you 
ever accidentally close the model and layout tabs below the command line, this is a place 
to turn them back on to make them visible. The other item to draw attention to is the 
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“Crosshair Size” sliding bar. This will allow you to change the size of your crosshairs in 
your drawing window. 
 

 
 

Open and Save Tab 

The Open and Save tab will allow you to set how you want the drawings to be saved and 
opened. Under the “File Save” section, there is a drop-down menu with the label “Save 
As”. The dropdown will allow you to set what version you want the drawing to saved back 
to. If you are working with other firms who do not have the latest version of AutoCAD 
installed, then you can save your drawings back to allow them to open the files. This can 
save much time going back and forth if you already have this setting saved to an older 
version. You can also set how often AutoCAD will automatically save a backup copy of 
your drawing. Under the “File Safety Precautions” heading, there is a checkbox for 
“Automatic Save”. You can also set the time between automatic saves. Be sure to look at 
this setting anytime you upgrade or get a new machine with a new install of AutoCAD. You 
should always have this setting checked and adjust the time to what best suits you.  
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User Preferences Tab 

The User Preferences tab is beneficial by allowing the user to make settings that once 
again will help them become more efficient. Under the “Window Standard Behavior” there 
is a button labeled “Right-Click Customization”. When you click this button, a window 
appears that will allow you to customize the right-click on your mouse. Each user should 
look at this setting in AutoCAD to see which settings will work best. I will typically have the 
“Time-Sensitive Right-Click” activated and the “Edit Mode” set to “Shortcut Menu”. Under 
this tab you can also see what the line weight settings are set to. This will allow you to 
change the default line weight thickness in your drawing. 
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Drafting Tab 

The Drafting tab will allow the user to make changes to AutoSnap and AutoTrack. On this 
tab you can change the size of the “AutoSnap Marker Size” and the “Aperture Size”. These 
should be set on your preference for how you want these to display. The user can also set 
the colors for helpful tools in AutoCAD. By clicking the “Colors…” button under the 
“AutoSnap Settings” section a window will appear. Within this window, you can select the 
“Context” of the drawing and then the “Interface Element”. If the user prefers a background 
color in model space, then select “2D Model Space” under the “Context” section and then 
select “Uniform Background” under the “Interface Element” section. Once you have those 
selections you can change the color to whatever makes it easier for you to view your 
drawing file under the “Color” section. If the user prefers a different color in the layout 
space, then you can select that heading under the “Context” section and change the color 
accordingly. 
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There are many other features associated with the options menu that I would encourage 
users to look through and make changes to improve efficiency. The options settings can 
be conducive if set up correctly for each user. 

 

Keyboard Shortcuts  

The keyboard shortcuts are keyboard combinations used to launch AutoCAD commands. For 
instance, you can press Ctrl+P to bring up the plot dialog box. This is the same effect as going to 
the big red A in the upper left-hand corner and clicking print. You can also directly type the 
corresponding keys. For instance, you can type “E” in the command line to erase an object. This 
is the same effect as clicking the erase button on the modify toolbar in the ribbon. Click the link 
below to access the Autodesk website that gives more information on keyboard shortcuts.     
 
https://www.autodesk.com/shortcuts/autocad 
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Below you will find the AutoCAD one-key shortcuts. These are the default settings.

 
 
You can also customize the key-in commands. The way I typically change the keyboard shortcuts 
is by accessing the acad.pgp file saved on your local machine. You can access this by clicking 
the “Tools” menu, then selecting “Customize”, then selecting “Edit Program Parameters 
(acad.pgp)”.  
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After you click the acad.pgp file will open in Windows Notepad. This file can be modified to set 
the keyboard shortcuts you prefer. I typically try to set commands on the left side of the keyboard 
to allow me to have one hand on the keyboard and one hand on the mouse while working. For 
example, I will set “C” equal to “Copy”, then “CC” equal to “Chamfer”. This method can be used 
for several other commands. Each user should decide if it is faster to enter keyboard commands 
are searching for the commands in the ribbon, menu, or toolbars. Below is an exert from the 
acad.pgp file. 
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You may also access the “Customize User Interface (CUI)” editor to access keyboard shortcuts. 
You can access this by clicking the “Manage” tab in the ribbon, then in the “Customization” pane, 
select the User Interface Please find the below 
   
https://knowledge.autodesk.com/support/autocad-lt/learn-
explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-LT/files/GUID-9970E91B-A4F5-405C-
99C1-46AD804A8858-htm.html 
 

Dimension Styles 

Dimensions styles are a great way to ensure your dimensional annotations are presented per 
client standards, correct information, presentation, and accurately reflect the drawing component. 
Dimension style setup and modifications are completed through the “Dimension Style Manager”. 
You can access the “Dimension Style Manager” by typing “dimsty” in the command line, by 
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clicking the arrow in the bottom right-hand corner of the dimensions panel under the “Annotate” 
heading, or by clicking “Format”, then selecting “Dimension Style”. 
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Dimension Style Manager 

The Dimension Style Manager is comprised of several components that will be expanded 
upon in the following to improve overall understanding and efficiency. 
 

 
 
One must first be familiar with all components and terminology associated with 
components of a dimension before moving forward with Creating and/or Modifying a 
dimension style. For this course and a general understanding of dimension components, 
the user will need to be familiar with the following terms: 
 
Dimension Line: Line which dimension is attached and connects the extension lines 
 
Extension Line: Line which connects the dimension line and the object which is being 
dimensioned 
 
Arrowhead: Visual object which indicates the termination point of the dimension line with 
the extension line as well as the termination point of leaders.  
  

Dimension Style Manager: Styles 

The “Styles” portion of the dimension style manager lists the dimension styles in the 
current drawing. It also indicates which of the styles listed is set current by highlighting it.  
 
Note: Styles will also indicate dimension styles, which are external references as well if 
the option is selected.  
 

Dimension Style Manager: List 

List dropdown controls in which styles are presented. For example, all styles will show all 
styles created in the drawing while styles in use will only show the dimension styles which 
are currently being utilized in the drawing.  
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Dimension Style Manager: Set Current 

Sets the selected style from “Styles” as the current dimension style. This will affect only 
dimensions that are created after the change is made.  
 

Dimension Style Manager: New 

This selection initiates the Create New Dimension Style Dialog Box, which allows you to 
create a new dimension style that better matches your company, client, project, or drawing 
needs. 
 
The first step to create a dimension style is to define the style name, which will be listed 
under in the dimension style manager. As well as defining which existing style you would 
like to use as a baseline to define your new style.  
 

 
 
Once “Continue” is selected the style will be created and the definition options will be 
displayed as follows: 
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Dimension Style New – Lines Tab 

 

 
 
The “Lines” tab is utilized to define all properties of lines associated with the new 
dimension style. “Dimension Lines” color, line type, and line weight can be defined to 
match required drafting standards. These can be set to “By Block” or “By Layer" and will 
inherit the properties of the layer which the dimension is placed. “Extend Beyond Ticks” 
controls how far the dimension line extends beyond the extension lines. The “Baseline 
Spacing” controls the default spacing between baseline dimensions. The option to 
suppress (display or not display) either side of the dimension line is also provided. 
 
Extension lines have similar options with the addition of a few. “Offset from Origin” sets 
the distance in which the extension line is offset from the location which the dimension is 
pulled. The user can also set a fixed extension line length by toggling the checkbox next 
to the “Fixed Length Extension Lines” call out. 
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Dimension Style New – Symbols and Arrows Tab 

 

 
 
The “Symbols and Arrows” tab controls the presentation of all symbols associated with 
dimensions. “Arrowheads” allows the user to select the type and size of the arrowhead, 
which is used. The “Center Mark”, “Dimension Break”, and “Linear Jog Height Factor” 
allow the size and/or scale of the indicated component to be adjusted as required by the 
user. “Arc Length Symbol” indicates position for the symbol to be placed if one is required. 
“Radius Jog Dimension” allows the jog angle to be changed.   
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Dimension Style New – Text Tab 

 

 
 
The “Text” tab controls the appearance and placement of dimension text. “Text 
Appearance” options allow the user to select an existing text style for the dimension text 
to follow. Also, the ellipsis will bring up the “Text Style Manager”. This area also allows for 
the text height and fraction scale to be set. “Text Placement” controls the position of the 
dimension concerning the dimension line as well as its spacing from the dimension line. 
“Text Alignment” sets the angular position between the dimension and dimension line.  
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Dimension Style New – Fit Tab 

 

 
 
The “Fit” tab sets automatic settings for placement of dimensions components based on 
the allotted space for the dimension text. “Fit Options” and “Text Placement” sets which 
component is relocated if there is not adequate space between the extension lines and 
the dimension texts secondary position. “Scale of Dimension Features” is the setting that 
adjusts the physical appearance of the dimension components to match the drawing scale, 
which is also referred to “Dimscale”.  
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Dimension Style New – Primary Units Tab 

 

 
 
The “Primary Units” tab is utilized to define properties associated with the unit of 
measurement present in each dimension. This covers both “Linear Dimensions” and 
“Angular Dimensions”. These settings include but are not limited to, Decimal, Scientific, 
Architectural, etc. “Measurement Scale” is a scale factor which multiplies the measured 
dimension by an appropriate factor. This is primarily used for items that do not match the 
overall drawing scale or working in model space/paper space. Refer to model space/paper 
space section of this presentation for discussion on “Dimassoc” system variable. This is 
also where the appearance of zeros is controlled through the “Zero Suppression” area.  
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Dimension Style New – Alternate Units Tab 

 

 
 
The “Alternate Units” tab shares the same settings as the “Primary Units” setting tab. 
However, sometimes, it is required to indicate both a primary and secondary unit. For 
example, inches and millimeters.  

  



Page 22 

Dimension Style New – Tolerances Tab 

 

 
 
The “Tolerance” tab controls the appearance and settings associated with any tolerance 
required. “Tolerance Format” sets the tolerance appearance and presentation of the units 
set up in the primary unit tab while the “Alternate Unit Tolerance” controls the same for 
other units. 
 

Dimension Style Manager – Modify and Override 

The “Modify” and “Override” options have identical settings as describe above for defining 
a new dimension style. The “Modify” option allows for a permanent modification to be 
made to a dimension style while an “Override” is temporary and is listed as an unsaved 
change for the dimension style.  
 

Dimension Style Manager – Compare 

The “Compare” option allows for two-dimension styles to be easily compared. This can 
also display the difference between the base and the override version of a dimension style. 
The comparison will result in a list of differences between the two and displayed for the 
user. 
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Layers Panel  

Layer Properties 

The layer properties manager allows you to add, delete, and rename layers. As well as 
change layer properties, set property overrides in layout viewports, and add layer 
descriptions. You can access the “Layer Properties Manager” from the “Layers” panel in 
the ribbon. 
 

 
 

 
 
The “Layer Properties Manager” window will pull up when you click the “Layer Properties” 
icon from the panel. The layer properties manager will display the layers that are loaded 
in your drawing. For each layer, the following headings are given: Status, Name, On, 
Freeze, Lock, Color, Linetype, Lineweight, Transparency, Plot Style, Plot, New VP Freeze, 
Description, VP Freeze, VP Color, VP Linetype, VP Lineweight, VP Transparency, and 
VP Plot Style. If you do not want to display any of these settings, you can simply right-click 
on the heading and uncheck the checkbox beside the heading you do not want to display. 
You can also sort the heading however best suits you and the type of drawings you are 
working on. If you click on a heading, the column will sort ascending or descending.   
 

LAYOFF 

Under the “Layers” panel in the ribbon, there is a button labeled “Off” or “LAYOFF”. This 
button will allow you to click on an object in your drawing and it will turn everything on that 
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layer off. You can also type “LAYOFF” in the command line to start the same command. 
This command is helpful if you need to look at an object unobstructed or if you need to 
turn layers off when printing. (Ex. Reference lines) 
 

 
 

LAYON 

Directly underneath the “Off” button is a button labeled “Turn All Layers On” or “LAYON”. 
This button will allow you to turn all the layers in the drawing on in one click. If the layer is 
also frozen, it will not become visible at this time. You can also type “LAYON” in the 
command line to start the same command. 
 

 
 

LAYISO 

Directly beside the “Off” button is a button labeled “Isolate” or “LAYISO”. This button will 
allow you to hide all layers except those of the selected layers. The layers that remain 
after clicking on an object are isolated. This command is beneficial when you want to view 
just one specific layer in a crowded drawing. You can also type “LAYISO” in the command 
line to start the same command. 
 

 
 

LAYUNISO 

Directly under the “LAYIOS” button is a button labeled “Unisolate” or “LAYUNISO”. This 
button will allow you to display all the layers that were hidden or locked by the layer isolate 
command. This command is beneficial when you want to quickly display all the layers that 
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you had previously frozen. You can also type “LAYUNISO” in the command line to start 
the same command. 
 

 
 

LAYFRZ 

Directly beside the “LAYIOS” button is a button labeled “Freeze” or “LAYFRZ”. This button 
will allow you to freeze the layer of the selected object. This command is beneficial when 
you want to freeze one layer at a time. This command will allow you to quickly freeze a 
layer that is in your drawing. You can select more than one layer at a time to freeze. You 
can also type “LAYFRZ” in the command line to start the same command. 
 

 
 

LAYTHW 

Directly under the “LAYFRZ” button is a button labeled “Thaw All Layers” or “LAYTHW”. 
This button will allow you to thaw all the layers that were previously frozen in the drawing. 
If the layer is turned off and frozen, it will still not become visible because it is turned off. 
If the layer is frozen in a viewport, you will still have to unfreeze the layer in the viewport 
to become visible.  This command will allow you to quickly display all the frozen layers in 
your drawing. You can also type “LAYTHW” in the command line to start the same 
command. 
 

 
 
TIP: AutoCAD still sees things that are on an “OFF” layer but does not see those items if 
the layer is “Frozen”. Therefore, regens are faster if layers are frozen. Also, you can turn 
off the current layer, but you cannot freeze the current layer. 
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External Reference  

You can insert any drawing file as an external reference (x-ref) in the current drawing. You can 
also insert types of image files. The benefit of using an x-ref is when the referenced drawing 
changes, it will update the current drawing. There are several methods for attaching x-refs; you 
can type “EXTERNALREFERENCES” or “XATTACH” in the command window, you can also go 
to the “View” tab, then “Palettes” panel, then “External References” palette, or you can go to the 
“Tools” menu, then click “Palettes”, then click “Reference Manager”. Any of these methods will 
open the external reference window. 
 

 
 
The default option for attaching an xref is a .dwg file, but if you click the drop-down arrow, you will 
see there are several other types of files you can attach. 
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When you click on the dwg icon, the “Select Reference File” window will appear. From there you 
will go to the location of the file you want to attach and click open. Then the “Attach External 
Reference” window will appear. From here you have a few different options. You can specify the 
insertion scale, the insertion point, the rotation, the path type, and the reference type. The Scale, 
Insertion Point, and Rotation can also be specified on screen if you click the “Specify On-Screen” 
option. There are two options for Reference Type; “Attachment” or “Overlay”. “Overlay” is best 
used when you want to insert a drawing as reference. When you use the “Attachment” option then 
the drawing becomes part of the master drawing. 
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After you have made the appropriate selections, the referenced file will appear in your master 
drawing. The referenced file will appear in the “External Reference” window. 
 

 
 
If you right-click on the referenced file, it will bring up a couple of options. You can “Unload” the 
file, and it will not appear in your drawing. It will still show up in the external reference window, 
but not be visible in your drawing. You can also go and “Reload” the file if you want it to reappear 
in your drawing. You can “Detach” the reference file, and it will no longer appear in the drawing 
or in the external reference window. You can “Bind” the referenced file to your drawing. Once you 
click bind it will bring up a dialog that gives you the options of “Bind” or “Insert”. You can also 
change the xref type from “Overlay” or “Attachment”. The last option you have is changing the 
path type in the bottom option. When you select the referenced file in the external reference 
window it will also display the location the file is saved at. 
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Model Space vs. Paper Space  

Model space/paper space can be a great way to layout drawings. Across the bottom of AutoCAD, 
below the command line, you will see “Model” and “Layout” tabs. The model space is where the 
objects of your drawing will be housed. In the layout tabs you will find the borders and annotations. 
A viewport is always placed in the “Layout” tab. A viewport can be explained as taking a sheet of 
paper and cutting a hole in it. By looking through the hole, you are primarily looking into model 
space. You can zoom in and out and pan around looking at the model space. 
 

Creating a viewport 

To create a viewport, you will first want to select the appropriate layout tab across the 
bottom. Then you will need to set the current layer to the layer that is reserved for your 
viewport window. (Ideally on a no print layer) Then click on the layout tab, and under 
Layout Viewports, you will see the options for viewports.  
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On the left side of the “Layout Viewports” panel, you will find options for inserting a 
viewport. A “Rectangular” viewport is the default, but you can also select a “Polygonal” 
viewport or “Object” viewport. 

 

 
 

Once you have selected the desired type of viewport, it will prompt you in the command 
window to select the corners of the viewport. Now that the viewport has appeared, you 
need to select the scale. To do this, select the viewport and go to properties. Within the 
properties window, there is a setting for “Standard Scale”. You can find in the status bar 
along the bottom a setting for selecting the scale of the selected viewport. These are the 
ways you can set the scale for the viewport.  
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Now that you have the scale set, you can reposition the viewport by the move command 
and resize the viewport by dragging the grips once you select the viewport. As soon as 
possible, you need to lock the viewport. By locking the viewport, you lock the scale, so 
you don’t accidentally change it. You can lock the viewport by selecting the viewport and 
either setting it to be locked in the properties window or by right-clicking, then select 
“Display Locked” and choose “Yes”. 
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Manipulating Layers in a Viewport 

Now that you have your viewport set in your drawing and it is locked, you have a few 
options to display objects in a viewport differently. When you double click inside the 
viewport, (and the viewport window becomes a thicker line), you are then in model space. 
Once inside the viewport, open your “Layer Properties” from the “Home” menu, under the 
“Layers” panel. 
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You will see that you have your standard settings for the layers, but you also have some 
viewport settings. From the “Layer Manager” you can change how an object shows up in 
the viewport. If you freeze the new viewport setting, then when you make a new viewport 
that layer will not display. If you have a layer showing in your viewport and you want to 
keep it turned on in model space but not displayed in the viewport, then you can click the 
icon under “VP Freeze”. The following setting will allow you change the color of an object 
inside the viewport but leave the color alone in model space. You can also change the line 
type and line weight settings for the viewport under the “VP” settings, this will also leave 
the settings in model space alone. 
 

Model Space and Paper Space on the Layout Tab 

When you are on the layout tab, and you have already created your viewports, you can 
double click inside the viewport to enter model space. Once you are ready to go back to 
paper space on the layout tab you can double click outside of the viewport. One way to 
tell if you are in model space or paper space on the layout tab is to look and see if the 
viewport border is a thin or thick line. If the viewport border is thick, then you are in model 
space. If the viewport border is thin, you are in paper space.  
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Viewport Clipping 

You can clip a viewport if you have inserted a viewport and need to make room to place 
other objects in the “Layout” tab. To clip a viewport, go to the “Layout” tab, and under 
“Layout Viewports” panel you will see the icon for “Clip”, or you can type “VPCLIP” in the 
command window. Once the command starts it will ask you to select a viewport, and then 
it will ask you to clip the viewport. This can be helpful if you already have your drawings 
setup but need to add something to your drawing, and you don’t want to have to change 
the scales of your viewports.  
 

 
 

Bonus Material 

Select Similar  

The “Select Similar” command will select objects of the same type (line, polyline, 
rectangle, circle, etc.). To execute this command, you select an object in your drawing for 
the category of objects that you want to select. Select the object, right-click and choose 
“Select Similar”.  
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Quick Select  

The “Quick Select” command creates a selection set by filtering by object type and 
property. To execute this command, you right-click to bring up the “Shortcut Menu” and 
select “Quick Select” or type “QSELECT” in the command line. 
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The Quick Select window will appear. From within this window, you can select if you want 
the selection to be for the objects selected in the drawing or the entire drawing. You can 
also select the objects you want the selection to apply to. Then you can select the 
properties that you want to filter your selection by. Once you select the property you can 
change what you want that value to be set to. The Quick Select command is beneficial for 
narrowing down your selection in a crowded drawing.  
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Selection Cycling  

Selection Cycling will allow you to toggle through objects that overlap each other. You can 
turn on selection cycling by clicking the “Customization” button in the bottom right and then 
pick selection cycling, or you can type “Ctrl + W” in the command line. When selection 
cycling is turned on, you pick on objects that are overlapping, then a window will appear 
that will allow you to toggle through the objects and select the one you want. This 
command is especially helpful when you are working with a point cloud and objects. 
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Isolate/Hide Objects  

The “Isolate Objects” command is another tool that will allow you to isolate objects not 
based on their layer, but simply by selecting the objects you want to display and select 
“Isolate Objects” from the taskbar or by typing “Isolateobjects” in the command window.  
 

 

 
Once you have initially isolated objects, you can select the icon in the taskbar and either 
isolate additional objects, hide objects, or end object isolation.  
 

 

 
You can also select objects and click the same icon in the status bar, then select “Hide 
Objects” or type “hideobjects” in the command line. This will hide the objects you had 
selected. 
 

 

 
Once you are ready to view all the objects again, you can select “End Object Isolation”. 
This tool is helpful when working in a congested 3d model; especially when you are trying 
to put in a connection with two perpendicular beams intersecting.   
 

 

 


